Room Acoustics Reporter
for XL2 Sound Level Meter

User Manual
V1.20
Index

1. Introduction ......................................................................................................................................... 4
2. Preparations ........................................................................................................................................ 5
   Software Installation ............................................................................................................................ 5
   Optional XL2 Sound Level Meter Requirements .................................................................................. 5
   XL2 with Firmware V4.50 or higher ....................................................................................................... 5
   XL2-TA with type approved Firmware V3.11 ...................................................................................... 5
3. Measurement with XL2 .......................................................................................................................... 6
   Mapping File for XL2 ........................................................................................................................... 6
   Set XL2 Memory Structure for Multiple Rooms .................................................................................... 8
   Perform Frequency Response Measurements ...................................................................................... 9
   Perform Reverberation Time Measurements ...................................................................................... 10
4. My First Steps using Room Acoustics Reporter .................................................................................. 11
   Data Import ........................................................................................................................................ 11
   Measurement Report ............................................................................................................................ 14
5. Main Menu .......................................................................................................................................... 16
   Toolbar .............................................................................................................................................. 16
   Menu .................................................................................................................................................... 21
6. Analysis and Reporting Views .......................................................................................................... 23
   Measurements View ............................................................................................................................ 24
   Calculations View ............................................................................................................................... 26
   Results View ...................................................................................................................................... 28
7. Measurement Report ............................................................................................................................ 31
8. Tolerances .......................................................................................................................................... 32
   Add Tolerance Band ............................................................................................................................. 32
   Import Tolerance ................................................................................................................................. 34
9. Simulation - Optimizing Room Acoustics .......................................................................................... 37
   Theory ............................................................................................................................................... 37
   Add Material / Object .......................................................................................................................... 41
   Import Material / Object ...................................................................................................................... 43
10. Standards .......................................................................................................................................... 46
    IEC 61260 - Octave or Third-Octave Spectrum ................................................................................. 46
GB 50371 - Code for sound reinforcement system design of auditorium .................................. 48
ANSI/ASA S12.2-2008 - Noise criteria curves NC .................................................................. 49
ANSI/ASA S12.2-2008 - Room noise criterion RNC ................................................................. 49
DIN 15996:2008 - Grenzkurven GK ....................................................................................... 51
ISO R 1996-1971 - Noise rating curves NR ........................................................................... 53
ISO 3382-1:2009 - Reverberation time in performance spaces ............................................. 55
ISO 3382-2:2008 - Reverberation time in ordinary rooms .................................................... 56
ASR A3.7 - Working Place ...................................................................................................... 57
DIN 18041:2016 - Acoustic quality in rooms ....................................................................... 59
ÖNORM B 8115-3:2015 - Room Acoustics ............................................................................. 61
ASTM C423-17 - Sound Absorption by the Reverberation Room Method ............................... 63
ISO 354:2003 - Sound absorption in a reverberation room ................................................... 65

11. Specifications ....................................................................................................................... 67

12. Revision-History ................................................................................................................... 69

13. End-User Licence Agreement .............................................................................................. 70
1. Introduction

Thank you for purchasing the permanent Room Acoustics Option or the annual Room Acoustics Reporter 365 license for the XL2 Sound Level Meter. This enables the import of the measurement data into the Room Acoustics Reporter PC-software. The Room Acoustics Reporter is a PC-based software application that reports reverberation time and noise spectrum measurements.

Designed for room acoustic experts, this comprehensive tool uses data gathered by the XL2 Sound Level Meter, and quickly returns graphical analysis of all measurement positions. Analyzing the measurement data and producing reports is straight-forward using the Room Acoustics Reporter software. Just drag & drop the XL2 measurement data into the software and print the report.
2. Preparations

Room acoustics describes how sound behaves in an enclosed space. Typical parameters to describe
this behavior are the reverberation time and the frequency spectrum of the sound in the room.
First the measurements are performed manually with the XL2. Then all data is imported into the
Room Acoustics Reporter software.

Software Installation

• Install the Room Acoustics Reporter software on your PC.

Optional XL2 Sound Level Meter Requirements

• Optional “Extended Acoustic Pack” for reverberation time measurements in 1/3 octave resolu-
tion.
• Optional “Spectral Limits” for measurements of Noise Curves or high-resolution frequency
response in 1/6 or 1/12 octave bands in the function 1/12 Oct.
• Optional „Cinema Assistent“ for frequency response measurements in the function Cinema
Meter.

XL2 with Firmware V4.50 or higher

• Ensure the latest firmware V4.50 or higher is installed in your XL2 Sound Level Meter.
• Request the online activation of the optional annual license “Room Acoustics Reporter 365”.
Alternatively you may install the Room Acoustics Option permanent in your XL2 Sound Level
Meter. This enables the data import into the Room Acoustics Reporter software.

XL2-TA with type approved Firmware V3.11

• Request the online activation of the annual license Room Acoustics Reporter 365. This enables
to import the measurement data into the software. Just ensure your PC is online during the data
import.
3. Measurement with XL2

Mapping File for XL2
The measurement task onsite is made up by multiple individual measurements. The XL2 Sound Level Meter may assign each of these measurements with a dedicated mapping, e.g. “T1” for the readings taken before adding absorption material in a room and “T2” afterwards. This feature supports automated post-processing and reporting in the Room Acoustics Reporter software.

- Load the text file “savenames.txt” with the user defined mapping, such as “T1, “T2”,... into the root directory of the XL2. The text file “savenames.txt” may be generated by the Room Acoustics Reporter software:

  - Click on **Settings**
  - Select the tab **Mapping**
  - Click **Export**
• Load the txt-file “savenames.txt” with the various mappings onto the root directory of the XL2.

• Next select “Autosave: Off” in the XL2 memory menu. This allows you to store each individual measurement with the desired mapping. The XL2 then uses the same mapping for subsequent measurements by default.
Set XL2 Memory Structure for Multiple Rooms

In applications with multiple rooms it is recommended to use a separate memory folder on the XL2 Sound Level Meter for each room. All measurements belonging to a single room are then stored in the same folder on the XL2 memory card. Each room will be an individual project later on in the Room Acoustics Reporter software.

- Connect the XL2 to the computer and select “Mass Storage”
- Open the folder “Projects”
- Generate new subfolders for each room, e.g. Room 1, Room 2, …
Perform Frequency Response Measurements

- Select the SLMeter measurement function on the XL2.
- Select the RTA screen and 1/3 octave resolution measurements.
- Ensure the frequency weighting Z is selected (= no weighting).
- Start the measurement.
- Stop the measurement after 15 seconds.

- Open the memory menu and select Save Test.
- The XL2 displays the Save Test pop-up; select Room-Acoustic at the right end of the first line.

- Select the applicable mapping
- Confirm your selection with the enter key and save the measurement. The XL2 saves the measurement data with a file name such as “L1_SLM_003_RTA_3rd_Report.txt”
- Continue with the further measurements “L1... etc.” in the same manner.
Perform Reverberation Time Measurements

- Select the RT60 measurement function on the XL2.
- Select 1/1 octave or 1/3 octave resolution (requires the optional Extended Acoustic Pack pre-installed in the XL2).
- Perform the reverberation time measurement.

![RT60 Measurement](image)

- Open the memory menu and select **Save Test**.
- The XL2 displays the **Save Test** pop-up; select **Room-Acoustic** at the right end of the first line.

![Save Test Pop-up](image)

- Select the applicable mapping
- Confirm your selection with the enter key and save the measurement. The XL2 saves the measurement data with a file name such as “T1_RT60_001_Report.txt”
- Continue with the further measurements in the same manner.
4. My First Steps using Room Acoustics Reporter

Data Import
The XL2 measurement data may be imported into the software by drag and drop. The minimum requirement for a successful data import is an XL2 with firmware V4.20 or higher. Instruments using an older firmware will benefit from the online activation of the option. The Room Acoustics Reporter software verifies the available annual subscription online during the data import.

- Start the Room Acoustics Reporter software.
- Click on File -> New

![New panel](image)

• The New panel opens with the default settings.
• Confirm with OK.
The measurement view with the message “Drop measurement files or folder here” is displayed.

- Kindly ensure, prior the data import, that the room folder contains all required measurement data (*.txt) and *.xl2 system files of each recorded measurement.
- Drag and drop the complete room folder from the XL2 memory card into the field Drop measurement files or folder here.
- Third-octave data may be imported into projects with octave band setting based on a linear average calculation (based on the German VMPA-Beschlussbuch 2015)

Room Acoustics Reporter offers further possibilities to import measurement data:

- Select all *.xl2 files in the room folder with all measurement data. Drag and drop the data into the Drop measurement files or folder here field.
- Click on File -> Import in the main window and select the File... or Folder... .
- Select the data set and confirm the selection.
The measurement data is imported.

The software offers the assignments T1 and T2. Measurement data may be assigned to T1 or T2 for comparison at a glance; e.g. before and after an acoustic treatment. By default all measurement data are assigned to the mapping T1.

In case you recorded the measurement data with mapping information in the file name, then the software assigns these data sets automatically; e.g. “T2_RT60_001.txt” is assigned to T2. Alternatively the mapping may be assigned manually:

- Select the measurement with the mouse.
- Click on the right mouse button.
- Select **Assign To**.
- Assign the measurement.
- Verify the measurement data and delete any false readings from the **Measurements** list on the right.
Measurement Report

- Select **View -> Calculations** in the menu.
- Verify the individual averaged results - the shaded area presents the measurement data span,
• Select the **View -> Results.**

  The averaged data is presented in a chart and a table.

  ![Image of chart and table displaying reverberation times](image)

  • Below the result table is the average reverberation time of the frequency bands 400 Hz to 1250 Hz in third-octave resolution reported.
  • Complete the header data with information about client, object, description, room dimensions and room volumes.
  • Print the Room Acoustics report.
    Alternatively save the report as pdf file, e.g. using https://www.tracker-software.com/product/pdf-xchange-lite.

  Congratulations, your report is completed!
5. Main Menu

Toolbar

1. New Project
   A project contains the measurement data of one room. The reporting is in accordance with the selected standard.
   - Select **Spectrum** or **Reverberation Time** for general data analysis or go for one of the dedicated standards.
   - Select the settings for the measurement data analysis and reporting.
   - Confirm with **OK**.

2. Open Project File
   Select an existing project file *.xlra.

3. Save Project File
   Save the actual data as room acoustics project file *.xlra.

4. Print Preview
   The measurement report for printing is displayed.

5. Print
   The measurement report is printed.

6. Import
   Select the folder containing the original XL2 measurement data, *.txt and *.xl2 files, and confirm with “Select folder”. All measurement files within the selected folder are imported into the software. Any recorded spectrum data with A- or C-weighting is automatically corrected to Z-weighting (=no weighting).

7. Measurements View
   The spectrum or reverberation time data is visualized in the selected frequency range. By default the measurement data are automatically assigned to either L1 or T1. For comparison one or multiple data sets may be assigned with L2 or T2 manually.
8 **Calculations View**
Displays the average of the measurement data. Individual data sets, e.g. outliers, may be removed from the average calculation.

9 **Results View**
Displays the following results based on the selected result type; e.g. for reverberation time:
- Table from 50 Hz - 10 kHz
- Chart from 50 Hz - 10 kHz
- Average reverberation time of selected frequency range

10 **Settings**
- **General**
  - Select settings for data analysis and reporting.

![Project Settings](image)
The measurement task onsite is made up of multiple individual measurements. The XL2 with firmware V4.20 or higher simplifies the data handling of these measurements by recording each data set with a dedicated before/after acoustic room treatments.

Storing the measurement data with this mapping on the XL2 supports the automated data assigning during the data import into the Room Acoustics Reporter software.

- Click on **Export...**; this generates the text file `savenames.txt`
- Load the txt-file “savenames.txt” with the various mappings, like “L1”, “T1”...
- onto the SD card of the XL2.
- Copy this file onto the root directory of the XL2 memory card
- Select the memory menu on the XL2 and set **Autosave: Off**

Each measurement can be manually stored on the XL2 with one of the predefined mappings.
Settings

Charts

Set the Y-axis scaling for all views.

![Project Settings Window]

- **T**: Min 0.0, Max 4.0 s
- **ΔSPL**: Min -10, Max 10 dB
- **A/V**: Min 0.0, Max 1.0 m²/m³
**Settings**

**Report**

- Load your company logo for the printed measurement reports
- **Align title to the left** offers more space for your company logo in the report header.
- **Hide equipment** offers more space for the description in the report.
- Set the **Name of the test institute**, e.g. your company name
- Load your **Signature** for the printed measurement reports

![Image of the NTi Audio logo and settings options](image)

The recommended maximum size for the imported picture is

- Logo: 120 x 30 px
- Signature: 350 x 70 px
Menu
The software offers the following menu functionalities:

**File**

- **New...**
  A project contains the measurement data of one room. The reporting is in accordance with the selected standard.
  - Select **RTA** or **Reverberation Time** for general data analysis or go for one of the dedicated standards.
  - Select the settings for the measurement data analysis and reporting.
  - Confirm with **OK**.

- **Open...**
  Select an existing project file *.*xlra.

- **Save**
  Save the actual Room Acoustics data as project file *.*xlra.

- **Save as...**
  Save the project with selectable name and path.

- **Print Preview**
  The measurement report for printing is displayed.

- **Print**
  The measurement report is printed.

**Import**

- **File...**
  Select a single measurement data file *.*xl2

- **Folder...**
  Select a folder in order to import all measurement data stored in this folder

- **Measurements from Project...**
  Select an old project and the measurement data of this project is imported

**Preferences...**

- **General**
  The Room Acoustics Reporter software is available in English and German language. The default setting uses the language of the operating system installed on your computer. Changing the language will require a restart of the software.

- **Tolerances**
  Maintain your list of tolerances for good/bad decision for all your reporting here.

- **Materials**
  Maintain your list of materials with absorption data for all your reverberation time reporting here.

**Recent**

Select a recently-opened project.
Close the software.

Cut the text from any text box.

Copy the measurement data selected in the right-hand Measurements, Calculations or Results box (e.g. for using it in Microsoft Excel).

Paste the copied text into any text box.

Delete the data selected in the right-hand selection box in Measurements.

Select all data in the right-hand Measurements box (applicable in Measurements View only).

Deselect all earlier selected data in the right-hand Measurements box (applicable in Measurements View only).

Set the frequency range for the calculation of the average reverberation time in accordance with ISO 3382-1 (applicable at reverberation time projects only).

Select the Measurements View.

Select the Calculations View.

Select the Results View.

Opens the Project Settings window.

Link to download the user manual in PDF form

Checks online for available updates of the XL2 Room Acoustics Reporter software.

Lists version and copyright details of the software.
6. Analysis and Reporting Views

The Room Acoustics Reporter software offers three views for fast data analysis and straight-forward reporting in accordance with the standard.

1. Measurements View
2. Calculations View
3. Results View
Measurements View

The software allows to assign reverberation time measurement data to the data set T1 or T2 for direct comparison; e.g. before/after room acoustic treatments. By default all data is automatically assigned to T1.

1. **Details**
   - Header data of the measurement report. The room area (= sum of floor, wall and ceiling surface) and volume are used to calculate predicted reverberation time with added absorption materials.
2 Measurements Chart
The original XL2 measurement data is visualized in the selected frequency range.

3 Y-Axis of Measurements Chart
Set the Y-axis in Settings -> Charts.

4 X-Axis of Measurements Chart
Set the X-axis in Settings -> General (as applicable).

5 Guideline Bar
Additional information about displayed measurement data is listed here.

6 Standard
Selected standard for the data analysis and reporting and formula for reverberation time projects.

7 Measurements List with Mappings
The software allows to assign reverberation time measurement data to the data set T1 or T2 for direct comparison; e.g. before/after room acoustic treatments. By default all data is automatically assigned to T1. The mapping T2 may be assigned manually:

- Select the measurement after room acoustic treatments with the mouse
- Click on the right mouse button
- Select Assign To
- Assign the measurement to T2

8 Image
Click into the image field and load a drawing or picture describing the room. The recommended maximum size is for
- A4 Reporting: 340 x 160 px
- Letter Reporting: 350 x 130 px
Calculations View

1. Client: Sample Inc.
2. Object: Office with wooden floor
3. Description: empty room w/o furniture
4. Room Lengths: 6.00 m
5. Room Widths: 5.00 m
6. Room Height: 3.00 m
7. Room Volume: 90.00 m³
8. Door Area: 3.00 m²
9. Wall Area: 66.00 m²
10. Date: 3/22/2019

Reverberation Time - Average T1

Measurements
- 2016-02-15_067Cycle 01 T1
- 2016-02-15_067Cycle 02 T1
- 2016-02-15_067Cycle 03 T1
- 2016-02-15_067Cycle 04 T1
- 2016-02-15_067Cycle 05 T1
- 2016-02-15_067Cycle 06 T1
- 2016-02-15_067Cycle 07 T1
- 2016-02-15_068Cycle 01 T1
- 2016-02-15_068Cycle 02 T1
- 2016-02-15_068Cycle 03 T1
- 2016-02-15_068Cycle 04 T1
- 2016-02-15_068Cycle 05 T1
- 2016-02-15_068Cycle 06 T1
- 2016-02-15_068Cycle 07 T1
- 2016-02-15_068Cycle 08 T1
- 2016-02-15_068Cycle 09 T1
- 2016-02-15_068Cycle 10 T1
Details
Header data of the measurement report. The room area (= sum of floor, wall and ceiling surface) and volume are used to calculate predicted reverberation time with added absorption materials.

Chart
The averaged measurement data is visualized in the selected frequency range. The grey area marks the measurement data span.

Y-Axis
Set the Y-axis in **Settings -> Charts**

Guideline Bar
Additional information about displayed measurement data is listed here.

X-Axis
Set the X-axis in **Settings -> General** (as applicable).

Standard
Selected standard for the data analysis and reporting and formula for reverberation time projects.

Measurements Selection
Disable any measurement data, which shall not be used for the average calculation.

Average
- Averaged data sets
  - Select e.g. Average T1 for detailed verifications of the measurement data used for the average calculation.
  - Press ESC on the keyboard to return to the default view with all averaged measurements
Results View

The Result View displays the following results:

- Table of the selected frequency range
- Standardized chart
- Calculated result
  - Reverberation Time: Average reverberation time of selected frequency range
  - Spectrum: Sum of all frequency bands
Details
Header data of the measurement report. The room area (= sum of floor, wall and ceiling surface) and volume are used to calculate predicted reverberation time with added absorption materials.

Results Table
Averaged results in the selected frequency range.

Calculated result
- Reverberation Time: Average reverberation time of selected frequency range
- Spectrum: Sum of all frequency bands

Guideline Bar
Additional information about displayed measurement data is listed here.

Chart
The averaged measurement data is visualized in the selected frequency range.
You may export the data set in your own individual reporting. Just click with the right mouse button into the chart and copy/paste the data.

Standard
Selected standard for the data analysis and reporting and formula for reverberation time projects.

Materials / Objects
Specify the area of plane absorbers or the quantity of objects selected.

Add Material / Objects
Add or remove plane absorbers or objects in the room.

Add... Add a new material and specify the absorption coefficients. The new material may be stored in the Preferences for other projects.

Search... Select an existing material from your database.

Results
Select the applicable result.

Tolerances
Select the applicable tolerance for passed/failed decision.
Image
Click into the image field and load a drawing or picture describing the room. The recommended maximum size is for
- A4 Reporting: 340 x 160 px
- Letter Reporting: 350 x 130 px
7. Measurement Report

The software generates automated reports in accordance with the supported standards. Print the reports for the selected results.

---

Reverberation Time RT60 in accordance with ISO 3382-2
Measurement of reverberation time in ordinary rooms

**Client:** Sample Inc  
**Object:** Office with wooden floor, empty room w/o furniture

**XL2 Sound Level Meter:** A2A-10929-E0 (M2230: 5742)

**Room Volume:** 50 m³  
**Room Surface:** 70 m²

<table>
<thead>
<tr>
<th>Freq f [Hz]</th>
<th>T1 RT60 [s]</th>
<th>Pred RT60 [s]</th>
<th>T1 Tolerance</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>2.81</td>
<td>1.20</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>2.86</td>
<td>1.18</td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>2.34</td>
<td>0.86</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>2.04</td>
<td>0.78</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>2.01</td>
<td>0.75</td>
<td></td>
</tr>
<tr>
<td>315</td>
<td>2.03</td>
<td>0.72</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>1.89</td>
<td>0.59</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>1.81</td>
<td>0.55</td>
<td></td>
</tr>
<tr>
<td>630</td>
<td>1.65</td>
<td>0.55</td>
<td></td>
</tr>
<tr>
<td>800</td>
<td>1.39</td>
<td>0.48</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>1.21</td>
<td>0.49</td>
<td></td>
</tr>
<tr>
<td>1250</td>
<td>1.07</td>
<td>0.44</td>
<td></td>
</tr>
<tr>
<td>1600</td>
<td>0.87</td>
<td>0.43</td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>0.85</td>
<td>0.44</td>
<td></td>
</tr>
<tr>
<td>2500</td>
<td>0.79</td>
<td>0.41</td>
<td></td>
</tr>
<tr>
<td>3150</td>
<td>0.69</td>
<td>0.38</td>
<td></td>
</tr>
<tr>
<td>4000</td>
<td>0.69</td>
<td>0.43</td>
<td></td>
</tr>
<tr>
<td>5000</td>
<td>0.68</td>
<td>0.49</td>
<td></td>
</tr>
</tbody>
</table>

**Mid**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>400</td>
<td>1.50</td>
<td>0.52</td>
</tr>
<tr>
<td>1250</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**No. of test report:** 1234  
**Date:** 22/05/2019  
**Name:** NTi Audio Inc.

---

www.nti-audio.com
8. Tolerances

Add Tolerance Band

- Click on the Edit Tolerance button in the right-hand column. The empty Tolerance window is displayed:

![Tolerance window](image)

- Complete the table with the upper tolerance. You may keep frequency bands without a tolerance empty.
- Repeat the same for the Low tolerance.
- Confirm with OK.
The result view displays the design goal tolerance.
Import Tolerance

- Select File -> Preferences... in the menu.
- Select Tolerances.

A table with demo tolerances is presented.

- Export the tolerances; an *.xml file is generated.
- Open the exported tolerance file using e.g. Microsoft Excel.
- Add your tolerances using the format of the demo tolerances.
- Save the data in *.xml format (e.g. Microsoft Excel offers “Save as type: XML Data”)
- Import the updated list of tolerances.
Your list with tolerances is available within the software now.

- Confirm with **OK** and return to the **Results View**.

-
Click on the drop down menu at **Tolerances** and select your preferred tolerance from the drop down list.
9. Simulation - Optimizing Room Acoustics

Theory

The reverberation time in rooms can be reduced with additional acoustic absorbers in the room; such absorbers are e.g. a fabric couch, a carpet, an acoustic picture or a special ceiling plaster. A reduced reverberation time also leads to a reduction in the sound level in the room.

The Room Acoustics Reporter software can be used to simulate the effects of additional acoustic absorbers installed in the room. The software calculates the expected reduced reverberation time T and the resulting sound pressure level change in the room. In addition, the A / V ratio and the mean sound absorption coefficient in the room are presented.

The standard simulation is carried out using Sabine's formula in accordance with the DIN EN 12354-6: 2004 standard. The Sabine’ formula was developed by the physicist Wallace Clement Sabine (1868-1919).

\[ T = \frac{0.16 \times V}{A} = \frac{0.16 \times V}{S \times \alpha_{\text{room}}} \]

with

T ... reverberation time [s]
V ... net volume of the room [m³]
A ... total or energy equivalent absorption area in the room [m²]
S ... sum of floor, wall and ceiling area [m²]
\( \alpha_{\text{room}} \) ... mean sound absorption coefficient of the room, without unit

Room Acoustics Reporter calculates the mean sound absorption coefficient in the room \( \alpha_{\text{room}} \) based on the measured reverberation time T1. For simplicity, possible sound absorption in the air and a reduced volume due to objects in the room are not taken into account. The sound velocity is assumed to be 345.6 m / s in accordance with the standard DIN EN 12354-6: 2004, so that the factor 0.16 can be used in Sabine’s formula.

The software simulates the effect of additional sound-absorbing materials, objects or people in the room. This allows to take the necessary measures for improved audibility in accordance with the specified tolerances. The absorbers are taken into account with the following formula:

\[ \alpha_{\text{room}} = \frac{(S_1 \times \alpha_1 + S_2 \times \alpha_2 + \ldots + S_i \times \alpha_i + A_{\text{obj}_1} + A_{\text{obj}_2} + \ldots + A_{\text{obj}_j})}{S} \]

with

\( S \) ... total or energy equivalent absorption area in the room [m²]
\( A_{\text{obj}_1}, A_{\text{obj}_2}, \ldots, A_{\text{obj}_j} \) ... absorption area of objects in the room [m²]
S ... sum of floor, wall and ceiling area [m²]

\[ \alpha_{\text{room}} \] ... mean sound absorption coefficient of the room, without unit

\[ \alpha_i \] ... sound absorption coefficient of absorber i, without unit

\[ A_{\text{obj}_j} \] ... absorption area of object j [m²]

**Example 1**

A rectangular room is 8 m long, 7 m wide and 3 m high. This results in a floor area of 56 m², a total surface of 202 m² and a room volume of 168 m³. The measured reverberation time at 1 kHz is 2 seconds. An acoustic ceiling with an area of 56 m² and a sound absorption coefficient of 0.8 at 1 kHz is placed in the room.

\[
\alpha_{\text{room}} = \frac{0.16 \times V}{S \times T} = \frac{0.16 \times 168}{202 \times 2} = 0.07
\]

The software now replaces an area of 56 m² with the mean sound absorption coefficient of the room against the acoustic ceiling with a sound absorption coefficient of 0.8.

\[
\alpha_{\text{with acoustic sealing}} = \frac{56 \times 0.80 + (202 - 56) \times 0.07}{202} = 0.27
\]

\[
T_{\text{with acoustic sealing}} = \frac{0.16 \times 168}{202 \times 0.07} = 0.49 \text{ s}
\]

**Example 2**

Continuing with example 1, the sound absorption coefficient of the ceiling, wall and floor is mostly different, so the accuracy of the simulation can be increased by removing the area of 56 m² with the actual sound absorption coefficient of the raw ceiling, e.g. 0.03 for concrete, and the 56 m² acoustic ceiling is added.

\[
\alpha_{\text{with acoustic sealing}} = \frac{202 \times 0.07 + 56 \times 0.80 - 56 \times 0.03}{202} = 0.28
\]

\[
T_{\text{with acoustic sealing}} = \frac{0.16 \times 168}{202 \times 0.28} = 0.48 \text{ s}
\]
In practice, Sabine’s formula is used to optimize room acoustics. This formula is based on the following assumptions:

- diffuse field in space
- evenly distributed absorbent surfaces in the room; In the case of opposing surfaces, the sound absorption coefficient should maximum differ by a factor of 3
- typical shoe box shape with dimensions with a maximum ratio of 1: 5 to each other
- not too many objects in the room; they may take up a maximum of 20% of the room volume

If these requirements are not met, the real reverberation time is often longer than the simulated reverberation time.

For applications with an average sound absorption coefficient greater than 0.30, the Sabine’s formula results in a longer reverberation times than actual. Therefore, in Room Acoustics Reporter you can alternatively select the formula of Eyring (1930), which provides the recommended and more representative reverberation time for an absorption coefficient > 0.30.

The formula is:

\[ T = \frac{0.16 \cdot V}{-S \cdot \ln(1 - \alpha_{\text{room}})} \]

with

- \( T \) ... reverberation time [s]
- \( V \) ... net volume of the room [m³]
- \( S \) ... sum of floor, wall and ceiling area [m²]
- \( \alpha_{\text{room}} \) ... mean sound absorption coefficient of the room, without unit

**Example 3**

The calculation is carried out using the same information as in Example 1 - but using Eyring’s formula. A rectangular room is 8 m long, 7 m wide and 3 m high. This results in a floor area of 56 m², a total surface of 202 m² and a room volume of 168 m³. The measured reverberation time at 1 kHz is 2 seconds. An acoustic ceiling with an area of 56 m² and a sound absorption coefficient of 0.8 at 1 kHz is placed in the room.

\[ \alpha_{\text{with acoustic sealing}} = 1 - e^{\left( \frac{0.16 \cdot 168}{-202 \cdot 2} \right)} = 0.06 \]

The software now replaces an area of 56 m² with the mean sound absorption coefficient of the room against the acoustic ceiling with a sound absorption coefficient of 0.8.
\[
\alpha_{\text{with acoustic sealing}} = \frac{56 \times 0.80 + (202 - 56) \times 0.06}{202} = 0.27
\]

\[
T_{\text{with acoustic sealing}} = \frac{0.16 \times 168}{202 \times 0.27} = 0.43 \text{ s}
\]

**Example 4**

Continuing with example 3, the sound absorption coefficient of the ceiling, wall and floor is mostly different, so the accuracy of the simulation can be increased by using an area of 25 m\(^2\) with the actual sound absorption coefficient of the raw ceiling, e.g. 0.03 for concrete, removed and the 25 m\(^2\) carpet added.

\[
\alpha_{\text{with acoustic sealing}} = \frac{202 \times 0.06 + 56 \times 0.80 - 56 \times 0.03}{202} = 0.28
\]

\[
T_{\text{with acoustic sealing}} = \frac{0.16 \times 168}{202 \times 0.28} = 0.41 \text{ s}
\]

The room becomes quieter with a reduced reverberation time - the direct sound component remains unaffected, but the sound reflections from the room boundary surfaces are reduced. This results in a lower sound pressure level. The Room Acoustics Reporter software shows the expected change in sound level; this is calculated from the following formula

\[
\text{Sound Pressure Level Change} = 10 \times \log \left( \frac{T_1}{T_2} \right)
\]

with

- \(T_1\) ... reverberation time [s]
- \(T_2\) ... expected reverberation time [s]

**Example 5**

With the results from example 1, the following change in sound pressure level results:

\[
\text{Sound Pressure Level Change} = 10 \times \log \left( \frac{2.00}{0.49} \right) = 6.1 \text{ dB}
\]
Add Material / Object

- Click on + next to Materials in the right-hand column.
- The following window is displayed:

- Enter Name and select the Location of the material in the room.
- Manufacturer and Description is optional.
- Complete the table with the Sound absorption coefficients $\alpha$.
- Confirm the data entry with OK.

The material is listed in the Materials field.

- Now enter the area of the absorption material in m².
The result view displays the predicted reverberation time adding the entered absorption material.

Note:
The absorption data is stored locally within the project. In case you like to have materials with absorption data available in all your reverberation time projects, then proceed with the next chapter.
Import Material / Object

- Select **File -> Preferences...** in the menu.
- Select **Materials.**

A table with demo absorption materials is presented.

- Export the materials; an *.xml file is generated.
- Open the exported material file using e.g. Microsoft Excel.
- Add your list of materials using the format of the demo materials.
- The **Name** of the material and **Location** in the room is required. Use **(Any)** in case the material can be used for the ceiling, the wall or the floor. **Manufacturer** and **Description** is optional like all other descriptors of the material or object.
- Save the data in *.xml format (e.g. Microsoft Excel offers “Save as type: XML Data”)
- Import the updated list of materials.
Your list of materials with absorptions materials is available for all reverberation time projects now.

- Confirm with OK and return to the Results View.
- Select the search icon next to Material / Object.
- Select the material of interest for your evaluation.
- Confirm the data entry with OK.
- Enter the area of the absorption material in m².

The result view displays the predicted reverberation time with the selected absorption material.
10. Standards

The Room Acoustics Reporter software measures and reports in accordance with the following standards:

IEC 61260 - Octave or Third-Octave Spectrum

Selecting the standard IEC 61260 enables to drag and drop noise spectrum data sets into the software Room Acoustics Reporter. With regards to the frequency band resolutions are octave and third-octave data supported. Data sets recorded with higher resolution are automatically calculated into third-octave band resolution.

Software Features

- Import of noise spectrum data for analysis and reporting
- Comparing two noise spectrum data sets (L1) and (L2)
- Standardized measurement reports
- Calculating Sum L1+L2 (log), Background Noise Correction L1-L2 (log) and Difference L1-L2 (lin)
- Calculating sum of user-specified frequency bands
- Import of data sets recorded with XL2 functions “1/12 Oct” or “Noise Curves”
- Automated aggregation of 1/12 octave and 1/6 octave data into one-third octave resolution
- Analysis of data sets based on frequency weighting A, C or Z
Alternatively you may also select **Spectrum** at starting a new project. The settings and functionalities are in accordance with the standard selection IEC 61260.
GB 50371 - Code for sound reinforcement system design of auditorium

This Chinese standard specifies various acoustic characteristics throughout a venue for different usage types. Such characteristics are the transmission frequency response, the transmission gain and the sound distribution as specified frequencies.

Software Features

- Import of measured noise spectrum in auditorium and reference
- Comparing sound level distribution with tolerance band specified by usage type
- Calculating transmission gain and sound distribution factors
- Copy/paste data set into customized reporting templates using e.g. Excel
- Standardized measurement reports with customer’s logo and information
- Passed / Failed result
ANSI/ASA S12.2-2008 - Noise criteria curves NC
The standard ANSI/ASA S12.2-2008 specifies a method how to quantify a background noise level in a room or other environment as a single value. The NC rating of a spectrum is designated as the value of the lowest NC curve above the measured octave-band spectrum. The designating number for any NC curve is, approximately, its Speech Interference Level (SIL): the average of the levels in the 500, 1000, 2000 and 4000 Hz octave bands. SIL is a simple metric, which measures the effects of noise on speech intelligibility.

Software Features
- Analysis of octave band spectra
- Automatic averaging of several spectra
- Calculates noise curve NC and speech interference level SIL
- Adding user-defined tolerances for pass/fail
- Third-octave band data or higher resolutions is aggregated in octave spectra
- Supports data from the functions SLMeter / RTA, Noise Curves, 1/12 Oct and Cinema Meter
- Flexible frequency weighting A, C and Z
- Analysis of Leq, Lmin, Lmax or L90 levels
- Tangency method adaptation according to ANSI/ASA S12.2-2008

ANSI/ASA S12.2-2008 - Room noise criterion RNC
The standard ANSI/ASA S12.2-2008 specifies a method how to quantify a background noise level in a room or other environment as a single value. The RNC method is used to determine noise ratings when the noise from HVAC systems at low frequencies is high, and which is also suspected of containing sizeable fluctuations or surging. It essentially represents a rumble criterion. The RNC curves also provide a procedure that reduces the result essentially back to the NC curves when systems are well designed and acoustically well-behaved. Following the RNC specification, the XL2 measures the octave-band sound pressure level every 100 ms, followed by processing to determine the applicable room noise criterion (RNC) curve.

Software Features
- Analysis of octave band spectra
- Automatic averaging of several spectra
- Calculates room noise criterion RNC
- Adding user-defined tolerances for pass/fail
- Third-octave band data or higher resolutions is aggregated in octave spectra
- Supports data from the functions SLMeter / RTA, Noise Curves, 1/12 Oct and Cinema Meter
- Flexible frequency weighting A, C and Z
- Analysis of Leq, Lmin, Lmax or L90 levels
- Tangency method adaptation according to ANSI/ASA S12.2-2008
### Octave Spectrum L1eq

<table>
<thead>
<tr>
<th>Frequency (Hz)</th>
<th>L1eq (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>55.6</td>
</tr>
<tr>
<td>31.5</td>
<td>46.5</td>
</tr>
<tr>
<td>63</td>
<td>40.7</td>
</tr>
<tr>
<td>125</td>
<td>44.0</td>
</tr>
<tr>
<td>250</td>
<td>45.3</td>
</tr>
<tr>
<td>500</td>
<td>36.3</td>
</tr>
<tr>
<td>1000</td>
<td>35.2</td>
</tr>
<tr>
<td>2000</td>
<td>36.8</td>
</tr>
<tr>
<td>4000</td>
<td>39.0</td>
</tr>
<tr>
<td>8000</td>
<td>41.8</td>
</tr>
</tbody>
</table>

**Noise Curves Result**

- **NC = 45 (8000 Hz)**
- **SIL = 37**
DIN 15996:2008 - Grenzkurven GK

The standard DIN 15996:2008 specifies a method for the qualification of background noise as a single value in studios and processing rooms for radio and television. During the production, assessment and processing of sound events, certain acoustic conditions in the rooms provided for this must be observed. An important criterion is the background noise level. Continuous noises occurs when the studio systems are switched on. Typical continuous noise sources are the background noise caused by the air conditioning system or other technical devices installed in the room.

Software Features

- Analysis of third-octave band spectra
- Automatic averaging of several spectra
- Calculates Grenzkurve GK
- Adding user-defined tolerances for pass/fail
- Data with 1/6 or 1/12 octave band resolution is aggregated in octave spectra
- Supports data from the functions SLMeter / RTA, 1/12 Oct and Cinema Meter
- Flexible frequency weighting A, C and Z
- Analysis of Leq, Lmin, Lmax or L90 levels
ISO R 1996-1971 - Noise rating curves NR

The standard ISO R 1996-1971 specifies a method how to quantify a background noise level in a room or other environment as a single value. Noise rating (NR) is a graphical method for assigning a single number rating to a noise spectrum. It can be used to specify the maximum acceptable level in each octave band of a frequency spectrum, or to assess the acceptability of a noise spectrum for a particular application. The method was originally proposed for use in assessing environmental noise, but it is now used frequently for describing noise from mechanical ventilation systems in buildings. To make a rating, the measured noise spectrum is superimposed on a family of NR contours; the NR of the spectrum corresponds to the value of the first NR contour that is entirely above the spectrum.

Software Features

- Analysis of octave band spectra
- Automatic averaging of several spectra
- Calculates noise rating NR
- Adding user-defined tolerances for pass/fail
- Third-octave band data or higher resolutions is aggregated in octave spectra
- Supports data from the functions SLMeter / RTA, Noise Curves, 1/12 Oct and Cinema Meter
- Flexible frequency weighting A, C and Z
- Analysis of Leq, Lmin, Lmax or L90 levels
ISO 3382-1:2009 - Reverberation time in performance spaces

The international standard ISO 3382-1 specifies methods for the measurement of reverberation time in performance spaces.

The “Room Acoustics Reporter” software supports the import of recorded measurement data, data analysis and standardized reporting. The software features are identical to the standard ISO 3382-2.
ISO 3382-2:2008 - Reverberation time in ordinary rooms

The international standard ISO 3382-2 specifies methods for the measurement of reverberation time in ordinary rooms, such as domestic rooms, stairways, workshops, industrial plants, class rooms, offices, restaurants exhibition centers, sport halls, railway and airport terminals.

The measurement of reverberation time is of interest to evaluate
- the sound pressure level from noise sources, the speech intelligibility and the privacy perception in a room
- the correction term for room absorption applicable e.g. at sound insulation measurements or sound power measurements

Alternatively you may also select **Reverberation Time** at starting a new project. The settings and functionalities are in accordance with the standard selection ISO 3382-2:2008.

![Screenshot of Room Acoustics Reporter](image)
ASR A3.7 - Working Place

The Technical Rules for Workplaces (ASR) represent the state of the art for setting up and operating workplaces in Germany. The ASR A3.7 specifies the requirements for reducing the sound pressure level at workplaces.

The “Room Acoustics Reporter” software compares the measured reverberation time at workplaces with the limit values specified in ASR A3.7; these limit values depend on the type of workplace and, in the case of educational institutions, also on the room volume. The corresponding selection can be made by the “Usage Type” in the software.

Software Features

- Import of reverberation time data before (T1) and after (T2) acoustic improvements
- Comparing reverberation time with limits and tolerance band
- Standardized measurement reports
- Simulating effect of added sound absorbing materials according to EN 12354-6
- Using Sabine or Eyring formula
- Presents sound pressure level change caused by added people and sound absorbing materials
- Calculates average sound absorption coefficient
- Calculates single number result (average of multiple frequency bands)

Differences to DIN 18041:2016

- Other Usage Types and limits
- No direct selection of person for 80% of the normal state of occupancy in the room
## Room Acoustics Reporter

### User Manual

#### Interface Overview
- **Client Name**: [Client Name]
- **Date of Test**: 8/3/2018

#### Room Dimensions
- **Room Lengths**: 6.00 m
- **Room Widths**: 4.00 m
- **Room Height**: 3.00 m

#### Volume Calculations
- **Volume**: 192.00 m³
- **Floor Area**: 54.00 m²
- **Wall Area**: 168.00 m²

#### Reverberation Time

<table>
<thead>
<tr>
<th>Frequency (Hz)</th>
<th>Pred</th>
<th>Pred</th>
<th>TI1</th>
<th>Pred</th>
<th>Pred</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>2.63</td>
<td>2.63</td>
<td>5.00</td>
<td>4.90</td>
<td>3.67</td>
</tr>
<tr>
<td>125</td>
<td>1.99</td>
<td>1.99</td>
<td>3.00</td>
<td>2.90</td>
<td>2.60</td>
</tr>
<tr>
<td>250</td>
<td>1.99</td>
<td>1.99</td>
<td>2.90</td>
<td>2.90</td>
<td>2.70</td>
</tr>
<tr>
<td>500</td>
<td>1.71</td>
<td>1.71</td>
<td>2.40</td>
<td>2.40</td>
<td>2.20</td>
</tr>
<tr>
<td>1000</td>
<td>1.62</td>
<td>1.62</td>
<td>2.10</td>
<td>2.10</td>
<td>2.00</td>
</tr>
<tr>
<td>2000</td>
<td>1.28</td>
<td>1.28</td>
<td>1.80</td>
<td>1.80</td>
<td>1.70</td>
</tr>
<tr>
<td>4000</td>
<td>1.06</td>
<td>1.06</td>
<td>1.50</td>
<td>1.50</td>
<td>1.40</td>
</tr>
</tbody>
</table>

#### Usage Type
- **One and Two Person Office**

#### Materials / Objects
- **Ceiling**: Cool Classic 30mm 30.00 m²

---

This page contains a detailed report on room acoustics, including measurements of room dimensions, volume calculations, and reverberation time analysis. The user interface is designed to provide a comprehensive overview of the acoustic properties of the space, ensuring compliance with standards and regulations.
DIN 18041:2016 - Acoustic quality in rooms

This German standard specifies the minimum acoustic quality of a room for a good speech intelligibility. It applies for rooms with a volume up to about 5’000 m³ and specifies room acoustic requirements and recommendations to ensure audibility. Sport halls and indoor swimming pools are supported up to 30’000 m³. The standard differentiates between the following two room groups:

- **Group A**
  - rooms with acoustic quality over medium and long distances
  - the acoustic quality is ensured by suitably adapting the reverberation time according to the specified tolerance band
  - typical rooms are e.g. classrooms in schools, group rooms in child day-care centres, conference rooms, court rooms, seminar rooms, lecture theatres, conference rooms, sport halls or indoor swimming pools

- **Group B**
  - rooms with acoustic quality over smaller distances
  - the acoustic quality is achieved by sound absorption and noise reduction according to the specified tolerance
  - people spend just a short period in these rooms
  - typical rooms are e.g. dining spaces, canteen, play hallways, changing areas in schools, exhibition rooms, entrance halls, offices or service counter areas

**Software Features**

- Import of reverberation time data before (T1) and after (T2) acoustic improvements
- Comparing reverberation time with tolerance band based on selected usage type for group A
- Comparing A/V-Ratio with tolerance band based on selected usage type for group B
- Standardized measurement reports
- Simulating effect of persons in the room for 80% of the normal state of occupancy
- Simulating effect of added sound absorbing materials according to EN 12354-6
- Using Sabine or Eyring formula
- Presents sound pressure level change caused by added people and sound absorbing materials
- Calculates average sound absorption coefficient
- Calculates single number result (average of multiple frequency bands)
### Room Acoustics Report

#### User Manual

**Client:** (Client Name)  
**Date of test:** 8/3/2018

<table>
<thead>
<tr>
<th>Room Lengths</th>
<th>Room Widths</th>
<th>Room Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.00 m</td>
<td>9.00 m</td>
<td>3.00 m</td>
</tr>
</tbody>
</table>

**Room Volume:** 162.00 m³

**Floor Area:** 54.00 m²  
**Wall Area:** 40.00 m²

### Data Sheet

<table>
<thead>
<tr>
<th>Frequency (Hz)</th>
<th>T1</th>
<th>Pred</th>
<th>R100</th>
<th>R500</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>2.61</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>2.56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>2.40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>2.15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>1.42</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>1.28</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4000</td>
<td>1.14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8000</td>
<td>0.78</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Usage Type

- A2: Speech/lecture

**Results**

- **Reverberation Time**

**People**

- Individual person in a group standing
- Person sitting on non-upholstered seating
- Person sitting on lightly upholstered seating
- Person sitting on seating with thick upholstery
- Children in pre-school centres
- Primary school pupils sitting at desks
- Secondary school pupils sitting at desks

### Materials / Objects

- Ceiling [m²]:
  - 0.00: Concrete
  - 30.00: Piasc 30mm

- Single object:
  - Panel

**DIN 10841:2016 - Acoustic quality in rooms**

---

**NTI Audio**

---

www.nti-audio.com  
Page 60 / 73
ÖNORM B 8115-3:2015 - Room Acoustics

This Austrian standard specifies the requirements for rooms in which, on the one hand, good audibility is to be ensured and, on the other hand, noise reduction is the primary goal.

The standard differentiates between the following usage types:

- Music
- Communication
- Speech Presentation
- Music
- Music Rehearsal
- Noise Reduction: furnished rooms
- Noise Reduction: no / less furnishing

Software Features

- Import of reverberation time data before (T1) and after (T2) acoustic improvements
- Comparing reverberation time with tolerance band based on selected usage type
- Comparing sound absorption coefficient with tolerance band based on selected noise reduction usage type
- Flexible frequency range setting
- Standardized measurement reports
- Simulating effect of added sound absorbing materials according to EN 12354-6
- Using Sabine or Eyring formula
- Presents sound pressure level change caused by added people and sound absorbing materials
- Calculates average sound absorption coefficient
- Calculates single number result (average of multiple frequency bands)
ASTM C423-17 - Sound Absorption by the Reverberation Room Method

The standard ASTM C423 specifies a test method for the measurement of sound absorption in a reverberation room by measuring the decay rate. Procedures for measuring the absorption of a room, the absorption of an object, such as an office screen, and the sound absorption coefficients of a specimen of sound absorptive material, such as acoustical ceiling tile, are described.

Software Features

- Import of reverberation time data of empty room (T1) and room with acoustic absorber (T2)
- Direct comparison of reverberation time T1 and T2
- Calculates sound absorption coefficient $\alpha_s$
- Standardized measurement reports
- Select the specimen types plane absorber, single object or array of objects
- Speed of sound calculated with actual temperature
- Calculation of attenuation coefficient according to ANSI S1.26

Differences to ISO 354:2003

- Speed of sound calculation
- Single number readings NRC (noise reduction coefficient) and SSA (sound absorption average) are used instead of $\alpha_W$ (weighted sound absorption coefficient)
- No specified calculation of absorption coefficients in octave-band resolution
- Sound absorption coefficients may differ by 0.01 - 0.02 to ISO 354
ASTM C423 - XL2 Room Acoustics Reporter 1.10.15

Client: [Client Name]

Object:

Description:

Room Volume: 125.00 m³

Specimen Area: 13.5 m²

Date of test: 2/27/2020

Sound Absorption Coefficient

<table>
<thead>
<tr>
<th>Freq (Hz)</th>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>1.67</td>
<td>1.70</td>
</tr>
<tr>
<td>63</td>
<td>2.23</td>
<td>2.12</td>
</tr>
<tr>
<td>80</td>
<td>1.93</td>
<td>1.98</td>
</tr>
<tr>
<td>100</td>
<td>1.78</td>
<td>1.80</td>
</tr>
<tr>
<td>125</td>
<td>2.61</td>
<td>2.65</td>
</tr>
<tr>
<td>160</td>
<td>1.62</td>
<td>1.67</td>
</tr>
<tr>
<td>200</td>
<td>2.40</td>
<td>2.60</td>
</tr>
<tr>
<td>250</td>
<td>2.48</td>
<td>2.13</td>
</tr>
<tr>
<td>315</td>
<td>2.45</td>
<td>2.10</td>
</tr>
<tr>
<td>400</td>
<td>2.35</td>
<td>1.90</td>
</tr>
<tr>
<td>500</td>
<td>2.37</td>
<td>1.90</td>
</tr>
<tr>
<td>630</td>
<td>2.14</td>
<td>1.78</td>
</tr>
<tr>
<td>800</td>
<td>1.66</td>
<td>1.59</td>
</tr>
<tr>
<td>1000</td>
<td>1.69</td>
<td>1.62</td>
</tr>
<tr>
<td>1250</td>
<td>1.48</td>
<td>1.38</td>
</tr>
<tr>
<td>1600</td>
<td>1.28</td>
<td>1.26</td>
</tr>
<tr>
<td>2000</td>
<td>1.12</td>
<td>0.93</td>
</tr>
<tr>
<td>2500</td>
<td>0.99</td>
<td>0.78</td>
</tr>
<tr>
<td>3150</td>
<td>0.82</td>
<td>0.68</td>
</tr>
<tr>
<td>4000</td>
<td>0.66</td>
<td>0.52</td>
</tr>
<tr>
<td>5000</td>
<td>0.62</td>
<td>0.48</td>
</tr>
<tr>
<td>6300</td>
<td>0.50</td>
<td>0.44</td>
</tr>
<tr>
<td>8000</td>
<td>0.44</td>
<td>0.40</td>
</tr>
<tr>
<td>10000</td>
<td>0.37</td>
<td>0.37</td>
</tr>
</tbody>
</table>

Temperature: 23.0 °C

Humidity: 40.0 %

Pressure: 100,000 kPa

NTI Audio

ASTM C423-17: Sound absorption by the reverberation room method

Rating

NRC = 0.25

SAA = 0.23
ISO 354:2003 - Sound absorption in a reverberation room

The international norm ISO 354 specifies a method of measuring the sound absorption coefficient of acoustic materials used as wall or ceiling treatments, or the equivalent sound absorption area of objects, such as furniture, persons or space absorbers, in a reverberation room.

Software Features

- Import of reverberation time data of empty room (T1) and room with acoustic absorber (T2)
- Direct comparison of reverberation time T1 and T2
- Calculates sound absorption coefficient $\alpha_s$
- Standardized measurement reports
- Select the specimen types plane absorber, single object or array of objects
- Speed of sound calculated with actual temperature
- Calculation of power attenuation coefficient according to ISO 9613-1
- Practical sound sound absorption coefficient $\alpha_p$ in accordance with ISO 11654:1997
- Weighted sound absorption coefficient $\alpha_w$
- Shape indicators L, M, H reported
- Classification of sound absorbers A - E
### Room Acoustics Report

**Client:** [Client Name]

**Object:**

**Description:**

- **Room Volume:** 125.00 m³
- **Specimen Area:** 12.5 m²

### Sound Absorption Coefficient

<table>
<thead>
<tr>
<th>Freq (Hz)</th>
<th>T1 (s)</th>
<th>T2 (s)</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>1.67</td>
<td>1.70</td>
<td>-0.01</td>
<td>0.20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>2.23</td>
<td>2.12</td>
<td>0.04</td>
<td>0.15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>1.93</td>
<td>1.78</td>
<td>0.16</td>
<td>0.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>1.78</td>
<td>1.32</td>
<td>0.10</td>
<td>0.10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>2.61</td>
<td>2.05</td>
<td>0.18</td>
<td>0.18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>2.42</td>
<td>1.67</td>
<td>0.16</td>
<td>0.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>2.43</td>
<td>2.09</td>
<td>0.12</td>
<td>0.12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>2.48</td>
<td>2.11</td>
<td>0.12</td>
<td>0.12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>315</td>
<td>2.43</td>
<td>2.10</td>
<td>0.11</td>
<td>0.11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>2.33</td>
<td>1.99</td>
<td>0.15</td>
<td>0.15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>2.37</td>
<td>1.90</td>
<td>0.10</td>
<td>0.10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>630</td>
<td>2.14</td>
<td>1.78</td>
<td>0.17</td>
<td>0.17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>800</td>
<td>1.68</td>
<td>1.31</td>
<td>0.22</td>
<td>0.22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>1.69</td>
<td>1.30</td>
<td>0.20</td>
<td>0.20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1250</td>
<td>1.45</td>
<td>1.24</td>
<td>0.21</td>
<td>0.21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1600</td>
<td>1.28</td>
<td>1.06</td>
<td>0.25</td>
<td>0.25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>1.12</td>
<td>0.93</td>
<td>0.32</td>
<td>0.32</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2500</td>
<td>0.99</td>
<td>0.76</td>
<td>0.51</td>
<td>0.51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3150</td>
<td>0.82</td>
<td>0.68</td>
<td>0.62</td>
<td>0.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4000</td>
<td>0.68</td>
<td>0.52</td>
<td>0.72</td>
<td>0.72</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5000</td>
<td>0.62</td>
<td>0.49</td>
<td>0.73</td>
<td>0.73</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6300</td>
<td>0.50</td>
<td>0.44</td>
<td>0.80</td>
<td>0.80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8000</td>
<td>0.44</td>
<td>0.40</td>
<td>0.87</td>
<td>0.87</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10000</td>
<td>0.37</td>
<td>0.37</td>
<td>0.97</td>
<td>0.97</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Rating:**

- $\alpha_a = 0.25$ (E)
- Class E

**ISO 354:2003 - Sound absorption in a reverberation room**
## 11. Specifications

<table>
<thead>
<tr>
<th>Standards</th>
<th>Spectrum</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- IEC 61260: Octave-band and fractional-octave-band filters</td>
</tr>
<tr>
<td></td>
<td>- GB 50371 - Code for sound reinforcement system design of auditorium</td>
</tr>
<tr>
<td>Noise Curves</td>
<td>- ANSI/ASA S12.2-2008 - Noise criteria curves NC</td>
</tr>
<tr>
<td></td>
<td>- ANSI/ASA S12.2-2008 - Room noise criterion RNC</td>
</tr>
<tr>
<td></td>
<td>- DIN 15996:2008 - Grenzkurven GK</td>
</tr>
<tr>
<td></td>
<td>- ISO R 1996-1971 - Noise rating curves NR</td>
</tr>
<tr>
<td>Reverberation</td>
<td>- ASR A3.7:2018 - Working Place</td>
</tr>
<tr>
<td>Time</td>
<td>- DIN 18041: 2016 - Acoustic quality in rooms</td>
</tr>
<tr>
<td></td>
<td>- ISO 3382-1:2009 - Reverberation time in performance spaces</td>
</tr>
<tr>
<td></td>
<td>- ISO 3382-2:2008 - Reverberation time in ordinary rooms</td>
</tr>
<tr>
<td></td>
<td>- ÖNORM B 8115-3:2015 - Room Acoustics</td>
</tr>
<tr>
<td>Sound Absorption</td>
<td>- ASTM C423-17 - Sound Absorption by the Reverberation Room Method</td>
</tr>
<tr>
<td></td>
<td>- ISO 354:2003 - Sound absorption in a reverberation room</td>
</tr>
</tbody>
</table>

| Reverberation Time | • 1/1 or 1/3 octave resolution |
|                    | • Averaging of multiple readings |
|                    | • Loading individual cycle results of measurement                      |
|                    | • Calculation of average reverberation time $T_{mid}$ in accordance with ISO 3382-1:2009 |
|                    | • Result simulation with added acoustic-absorbing materials or additional persons in the room according to EN 12354-6 |
|                    | • Import or export materials with absorption coefficients |
|                    | • Edit absorption coefficients |
|                    | • Estimate predicted reverberation time |
|                    | • Upper and lower tolerance for passed/failed decision |

| Spectrum (RTA) | • 1/1 or 1/3 octave resolution |
|               | • Averaging of multiple readings |
|               | • A, C and Z-weighting |
|               | • Calculations |
|               |   - Sum of multiple noise spectra |
|               |   - Background noise correction |
|               |   - Difference $D$ |
|               |   - Broadband level |
|               | • Import or export tolerances |
|               | • Upper and lower tolerance for passed/failed decision |
| Reporting                  | • PDF via PDF-printer  
|                           | • XPS                  
|                           | • Data Export: Copy/paste data as image or text into User Reports |
| Languages                 | • English, German, Chinese |
| Operating System          | • Windows Vista, 7, 8.x and 10 |
| Licensing                 | • Activated annual subscription service “Room Acoustics Reporter 365” online at my.nti-audio.com or permanently installed “Room Acoustics Option” in XL2; this enables the import of measurement data into the software  
|                           | • Room Acoustics Reporter can be installed on multiple computers. |
| XL2 Requirements          | • Installed optional Extended Acoustic Pack to measure the reverberation time in 1/3 octave band resolution. |
| Order Information         | • Room Acoustics Reporter 365 (annual subscription service)  
|                           | NTi Audio # 600 000 441  
|                           | • XL2 Room Acoustics Option (permanently installed option in XL2)  
|                           | NTi Audio # 600 000 440 |

All information is subject to change without notice.
12. Revision-History

Release V1.10, Sep 2019
- Enable third-octave data import into reverberation time octave project
- Increased maximum for room parameters and material area

Release V1.20, Sep 2020
- Added standards
  - GB 50371 - Code for sound reinforcement system design of auditorium
  - ANSI/ASA S12.2-2008 - Noise criteria curves NC
  - ANSI/ASA S12.2-2008 - Room noise criterion RNC
  - DIN 15996:2008 - Grenzkurven GK
  - ISO R 1996-1971 - Noise rating curves NR
  - ASR A3.7:2018 - Working Place
  - ISO 3382-1:2009 - Reverberation time in performance spaces
  - ÖNORM B 8115-3:2015 - Room Acoustics
  - ASTM C423-17 - Sound Absorption by the Reverberation Room Method
  - ISO 354:2003 - Sound absorption in a reverberation room

- Reverberation Time
  - View the parameters sound pressure level change, sound absorption coefficient $\alpha$ and $A/V$-ratio with individual tolerance setting
  - Support negative area for materials and a negative quantities for objects
  - Sound absorption formula according to Eyring
  - Flexible room volume and room boundary surface calculation
  - Generate a T2 report even without T1 data available
  - Move usage type selection from project settings to result view for DIN18041
  - Add columns for website, distance, thickness, absorption coefficient $\alpha$, absorption class, SAA and NRC to the materials table
  - Separate adding materials in edit and search material
  - Setting of frequency range for average reverberation time calculation

- Spectrum
  - Allow import of XL2 data recorded in the functions 1/12 Octave, Cinema and Noise Curves

- General
  - Selecting the general Spectrum and Reverberation Time reporting no longer lists an individual standard in the report header
  - Import measurements from project
  - Add chinese language
13. End-User Licence Agreement

This End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and NTi Audio AG ("NTi Audio"). By installing or using the NTi Audio software, content or documentation (collectively the "NTi Audio software") accompanying this EULA, you accept these terms and are consequently bound to them. If you do not agree to the terms of this EULA, do not install or use the NTi Audio software.

The NTi Audio software is licensed not sold, to you by NTi Audio for use only under the terms of this license agreement. This EULA only gives you some rights to use the software. You may use the software only as expressly permitted in this EULA.

This EULA also applies for all upgrades or updates to the NTi Audio software (if any), supplements, internet-based services, and support services for this NTi Audio software, unless other terms accompany those items. If so, those terms will govern.

License Uses and Restrictions

A. Software Installation: Subject to the terms and conditions of this license agreement, you are granted a limited, non-exclusive license to use and run the NTi Audio software. Data transfer from an NTi Audio test instrument to the NTi Audio software may be restricted, i.e. only enabled if the corresponding license is installed on the analyzer.

B. No Reverse Engineering: You may not and you agree not to, or to enable others to, copy (except as expressly permitted by this license agreement or by the usage rules if they are applicable to you), publish, distribute, decompile, reverse engineer, disassemble, attempt to derive the source code of, decrypt, modify, or create derivative works of the NTi Audio software or any services provided by the NTi Audio software, or any part thereof.

C. Termination: This license is effective until terminated. Your rights under this license agreement will terminate automatically or otherwise cease to be effective without notice from NTi Audio if you fail to comply with any term(s) of this license agreement. Upon the termination of this license, you must cease all use of the NTi Audio software and destroy all copies, full or partial, of the NTi Audio software.

Services

The NTi Audio software may enable access to NTi Audio and third party services and web sites (collectively and individually, "NTi Audio services"). Such NTi Audio services may not be available in all languages or in all countries. Use of these NTi Audio services requires internet access and use of certain NTi Audio services may requires an NTi Audio ID, may require you to accept additional terms and may be subject to additional fees. By using this software in connection with an NTi Audio ID or other NTi Audio account, you agree to the applicable terms of service for that account.

Disclaimer

A. NTi Audio and all our affiliates do not give any warranty, guarantee or conditions for this software, i.e. you bear the sole risk of using it. This limitation applies to anything related to this software, including breach of contract, warranty, guarantee or condition, strict liability, negligence or other tort to the extent permitted by applicable law. It also applies if NTi Audio knew or should have known about the possibility of the damages.
B. The NTi Audio software and services are provided “as-is”; i.e. with all faults. You bear the sole risk of using it. NTi Audio gives no express warranties, guarantees or conditions. NTi Audio excludes the implied warranties of merchantability, fitness for a particular purpose and non-infringement.

C. You acknowledge that the NTi Audio software and services are not intended or suitable for use in situations or environments where the failure or time delays of, or errors or inaccuracies in the content, data or information provided by the NTi Audio software or services could lead to death, personal injury, or severe physical or environmental damage, including without limitation the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, life support or weapons systems.

D. No oral or written information or advice given by NTi Audio or an NTi Audio authorized representative shall create a warranty. Should the NTi Audio software or services prove defective, you assume the entire costs of all necessary servicing, repair or correction.

E. In no event shall NTi Audio be liable for personal injury, or any incidental, special, indirect or consequential damages whatsoever, including, without limitation, damages for loss of profits, loss of data or information, business interruption or any other commercial damages or losses, arising out of or related to your use or inability to use the NTi Audio software or services or any third party software or applications in conjunction with the NTi Audio software or services, however caused, regardless of the theory of liability (contract, tort or otherwise) and even if NTi Audio has been advised of the possibility of such damages. In no event shall NTi Audio’s total liability to you for all damages exceed the amount of ten US dollars (USD 10.00). The foregoing limitations will apply even if the above stated remedy fails of its essential purpose.

Separate Provisions
If any provision of this EULA shall be held to be invalid, illegal or unenforceable, the validity, legality and enforceability of the remaining provisions shall in no way be affected or impaired thereby.

Privacy
At all times your information will be treated in accordance with NTi Audio’s privacy policy, which is incorporated by reference into this license agreement and can be viewed at http://www.nti-audio.com/privacy-statement

Controlling Law
This license agreement will be governed and construed in accordance with the laws of Liechtenstein, Europe, excluding its conflict of law principles. No amendment to or modification of this EULA will be binding unless in writing and signed by NTi Audio. The English version of this EULA shall govern, to the extent not prohibited by local law in your jurisdiction.